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1. Define the following terms

Aspic

T o

Beurre noir

Beurremanie

a o

Bisque
Liason
f.  Espagnole
2. Define the following terms:

Goulash

T o

Jardiniére

Maitre d'hétel Butter

o o

Mirepoix
Roux
f. Jus
Explain the compositions of salads in detail
Explain any two types of dressing
What is the principle of salads?
Explain different Types of salads.
Write any 4 international salads with country of origin.

What are simple salads? Give two examples of simple salads.
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Write the names of 5 types of lettuce.

10. Write a basic recipe for making classical mayonnaise.
11. Explain 3 basic classical vinaigrette dressings.

12. Define Sauces and their uses in a commercial kitchen.
13. Explain the Importance of Sauces in Food Production.
14. Enlist the Mother Sauces with 2 derivatives of each.

15. Enlist and explain the thickening agents used in sauces.
16. Give examples of miscellaneous sauces.

17. Explain the ratio of Béchamel sauce with 2 derivatives.
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Define Proprietary sauces with examples.

Write the Difference between sauces and stocks.
Define stocks and enlist the types.

Make a list of different types of stocks with the ingredients used in them.
Give recipe for 1 liter of brown stock.

Define Glazing.

Explain in brief the rules of stock making.
Explain the term Mirepoix and Bouquet garni?
Explain the essential parts of the stock?

Draw the labeled diagram of an egg structure.
What are the 6 sizes of eggs?

Explain any 5 types of egg preparation?

What are the various uses of eggs in food preparation?
Write the procedure of plain omelet making with ingredients?
What are the selection criteria for an egg?

What are the Components of a sandwich?

Write types of Closed hot sandwiches and enlist 2 examples of each
Write any 2 Examples of breads spreads and filling.

What is BLT? Explain in detail.

What is important the rules of sandwich making?

Define the sandwich with a labeled diagram.

Draw a Classification of soups with one example of each.
Give 5 international soups with their country of origin.
Explain consommé with 2 examples.

Write 5 Examples of consommé with its garnishes.

Give the clarification process of a consommé in detail.

Write the recipe for consommé for 1 liter.
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Define velouté sauce with 2 derivatives?

Enlist the important points for service and preparation of soups.
Write the aims of soup making.

Explain in brief the broth?

Enlist the ingredients for making stock and explain.

Enlist the classic garnishing for soups

Enlist the Precautions to take while Preparing and Storing sandwich
Enlist the points to be taken care for Handling and storage of sandwich
Define Roux and explain the types

Name the Emulsification based Sauces.

Definition of convenience food.

Explain any 2 processing methods of convince food with examples
Write the advantages and disadvantages of convenience food.
Enlist 5 example of ready to cook food available in market.

Enlist 5 example of ready to eat food available in market.

Explain utility of convenience food in current trends and life style.
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Write a note on Breakfast Door Knob.

Classify Sandwiches and give 2 examples of each.

Write the first 6 courses of the classical French menu with 1 example.
Plan an English breakfast menu with the cover.

Explain mobile room service.

List down accompaniments of Caviar.

What is a proprietary sauce?

What is Spoom?

What is an Elevenses meal?

. Explain what speciality coffee is? Give 3 examples of the speciality coffees.

. What is a Cloche?

. How Vinaigrette dressing is made?

. What is Parfait?

. When is Supper served?

. Classify non-alcoholic beverages.

. What is the advantage of Room service?

. List down 4 coffee-making methods and explain Turkish coffee and cona coffee methods.
. Give 05 examples of the Savoury course with the cover required for the same.
. Plan an Indian menu with starters, main course and a sweet dish.

. Plan 17 courses with one example.

. Differentiate between TDH and A La Carte.

. Write 05 Considerations to be kept in mind while planning the menu.

. Write 05 Constraints while planning the menu.

. Explain California and the working lunch menu.

. What is a continental breakfast menu? Mention 02 types of the same.

. What is a Fast Food or QSR menu?

. Write Cover and accompaniments for the Fruits and Nuts & Cheese course.

. What is the cyclic menu?

. How different is a working lunch menu from a lunch menu?
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What is a Take-Away menu?

What is Afternoon tea? Plan a menu.

Plan a full English breakfast menu.

What are Tisanes? Give 04 examples of Tisanes.

Write definition and evolution of the term menu.

What is plat du jour? Explain with examples.

What is a perforator method of making coffee?

What are natural spring water and mineral water? Give examples of each.
Draw the chart for the classification of beverages.

What is a minibar?

What is Fondue? Write its service procedure.

Explain scheduling and staffing in F & B Department.

What is a salad? Write its components?

Write down general principles of room service.

Give the importance of Time management in IRD?

Draw any two in-room specimens used in-room service.
Explain any two Classic salads.

What is a frozen dessert? Write any two in detail.

Draw an IRD layout.

Plan a 3-course French menu.

Explain the function of beverages.

What is Hors d’'oeuvre? Explain any two with examples.
What is Sorbet? Give examples.

Explain any two special equipment used in Room service.
What do you mean by digital menu? Explain with examples.
List down the rules of planning a menu.

What a note on religious dietary factors affecting a menu planning.
What do you mean by a vegan diet?

Write Cover and accompaniments for the smoked salmon.
Plan a 6-course menu with Sorbet and Fromage.

Explain Vegetarianism and write its forms.
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Definition of control desk, and what is the importance of Control desk?
What are the various functions of Housekeeping control desk?

What are the different duties of control desk attendant?

List and explain the five registers maintained in housekeeping control desk.
Write a short note on -

a) Key Control Register

b) Lost and found registers

Lost and Found Procedure explain with classification

Explain in detail, Mini bar operations

List and explain the various types of beds

What are the various types of mattress? Write any five

. What are the various types of pillows? Write any five
1.
12.
13.
14.
15.
16.
17.
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23.
24,
25.
26.
27.

Write a short note on Concept of pillow menu

What are the various types of bedding? Write any five

Write a short note on Opening the House

What are the various rules of the floor?

Draw the formats of - Duty Roaster and Cleaning Schedules

Write a short note on - Evening Service and Second Service

Explain in detail, Daily Routine of housekeeping department

Write a short note on - VIP List and List of Rooms

Give the difference between Departure register and Expected arrival register

Write a short note on - Guest loan articles register and Maintenance / Breakage Register
How many stages are there in Guest Cycle? And which is first stage of guest cycle.
Which form is generated in Pre-Arrival Stage?

What is Blocking of Rooms?

What is Retention Charges?

Define Blocked.

What are different modes of Reservation?

What are various sources of Reservation
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What are types of Reservation
Define waitlisted Reservation
Explain importance of Reservation
Explain the procedure of VIP registration
Explain what is C Form
Expand VISA
What all forms generated during Arrival Stage.
What do you understand by ATG?
What is Rooming List
Explain Guest room Change.
Explain the Importance of Key handling
Who provides information of City Tours
Differentiate between concierge and bell desk.
What is Message Coordination?
How is mail handling done in Hotel?
What is guest paging?
Explain role of safety deposit locker.
Explain the daily cleaning routine of occupied room in detail.
Explain the daily cleaning routine of a departure room in detail.
Explain daily cleaning procedure of VIP rooms.
What is second service and give the procedure for the same?
Explain spring cleaning and why is it important?
Explain the cleaning routine for coffee shop and guest corridors.
Explain the daily cleaning procedure for Spa and swimming pools.
Explain the daily cleaning procedure for Casinos and Lounges.
Explain the daily cleaning procedure for Parking and staircases.
Explain the procedure for cleaning Left luggage rooms and lobby.
Define PMS & name and explain types of PMS in detail.
Draw a flow chart to explain the PMS of a reservation system.
Name any 5 software used in hotels.
Explain the terms: -
1. Checkin 29. FHRAI
2. Check out 30. HRACC
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Walk in
Meal Plan
Suite

55-56, Shivajinagar, Pune — 411005

Guaranteed Reservation

PMS
FIT
Full Board

. DND
11.
12.
13.
14.
15.
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24,
25.
26.
217.
28.

Concierge
GHC

Crew
American Plan
MAP
European Plan
Continental Plan
Overbooking
Cancellation
Waitlist

No show
Understay
Master Key
Motel

Heritage Hotel
Floatel

GRE

Left Luggage Room
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Q.1 Write in words (French)? (Any 5)
1.18

2.52
3.97
4.4

5.83
6. 69

Q.2 Give French names for the following? (any5)
1. 2 Vegetables

2. 2 Fruits

3. 2 Milk products

4. 2 Wine Terms

5. 2 Seafood & Fish names

6. 2 herbs & Spices

Q.3 Conjugate following verbs to complete the sentence? (Any 5)

1. Tu-— (Manger) les oeufs pour le pétit déjeuner.

2. Vous - (couper) les tomate et fair du salade de la tomate.
3. Je---- (étre) étudiante de I'Hotelerie.

4. |l------(Parler) anglais et Frangaise

5. Nous------ (avoir) les examen semaine apres.

6. Elle - (chanter) bien .

7. M- (regarder) le television tous jour.

Q.4 Answer following question? (Any 5)

1. Qelle date est-ce-que au jourdui?
2. Quelle heure est- iI?

3. Comment allez -Vous?
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4. Quelle est votre nationalite?
5. Ou habitez -Vous?

6. Quelle est votre nome s'il vous plait?

Q.5 Conjuguez les verbes au présent et récrivez les phrases (any ten)

[Conjugate the verbs in the present tense and rewrite the completed sentences]

(1) Nous........ccevvenne. (préparer) un gateau.

(2) (Caler) ....overvrrrernen. les ceufs !

(3) Nous.....cocvevrrrenee. (ne pas vendre) de billets.

(4) (AVOIr) o, -vous des serviettes?

(5) Je.iii, (se reposer) aprés le travail. (6) (Monter) ..........cc.c........ les blancs d’ceufs en
neige ferme.

(7) Nous......cocvvevrenee. (jouer) de la guitare pour la féte.

(8) Vous......cccoeunee. (contacter) une agence de voyages.

() NOUS.....ccoiiiiiiiieeeiiiicee e, (chanter) les chansons

(106 oo (etre) Etudiante

(1)Jeiii (aller)a la gare

(12)Vous.................. Vouloir du Café

Q6. (A) Donnez les équivalents en francaise
Give Equivalents in French for the following (any 5)
a. onions
b. cheese
C. wine
d.Chicken
e. Eggs

f.Tomato

Q.7 Ecrivez la date en frangais (any 2):
[Write the date in French]
(1) Saturday 8/3/2011
(2) Monday 1/1/2008
(3) Friday 29/9/2001.

10
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Q8. Quelle heure est-il (any two):
What time is it? Write in French]
(1) 7.10 a.m.

(2) 3.40 p.m.

(3) 12 noon

(4)6am

Q9.

Donnez les équivalents en anglais (any five) :

[Give the equivalents in English]

(1) gros sel

(2) maquereau
(3) viande
(4) dinde (5) pamplemousse

(6) curcuma.

Q10. Ecrivez les nombres en lettres (any five):

[Write the numbers in words in French]

(1)

1st.

(2) 29th

(3)

16

(4) 40
(5) 10th
(6) 100.

Q.11 Expliquez les termes en anglais (any 10).

Explain the terms in English (any 10)

1)
)
3)
(4)
()
(6)
(")
(8)
9)

demi glace
crodtons

au gratin

levure chimique
beurre fondu
alacarte

bistro
béchamel

petit four

11
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(10) gumbo

(11) crépe suzette

(12) foie gras

Q.12 Ecrivez la date (any 2)
Write the date (any 2)

(1) Monday, 1st April

(2) Saturday, 29th February

(3) Tuesday, 8th September
Q.13Quelle heure est-il (Any 5)
What time is it? (Any5)

(1) 7.15a.m.

(2) 2.30 p.m.

(3) 12.00 a.m.

(4) 10.45 p.m.

(5) 12.00p.m.

(6) 8.00a.m.

Q.14 Mettez la bonne mesure (any 5)

Put in the correct measure (any 5)

(1) e de sel

(2) o, de raisins
() I de girofle

() de rin

() I du lait

(6) FRTPPPPPRT de la biere

Q.15 Ecrivez les nombres en lettres (any 5)
Write the numbers in words (any 5)

(19

(2) 100

(3) 36

4) 71

(5) 50

6) 20
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Q.16 Nommez le chef

Name the chef

(1) S'occupe du petit-déjeuner

(2) Prépare toute sorte de patisseries

(3) Se charge des mets grilles

(4) Se Charge des Entrmetier

(5) Se charge du Potage

Q.17 Donnez un exemple en frangais de (any 5)
Give one example each in French (any five)
(1) fromage

(2) Légumes

(3) Fruit de la mer

(4) Fruit

(5) Viande

(6) produits laitiéres

(7) Herbes et épices

Q.18 Nommez Suivant
(1) Nommez deux fruits (Name two fruits.)
(2) Nommez deux fromages. (Name two cheeses.)

(3) Nommez deux fruit de la mer. (Name two red wines.)

(4) Nommez deux ) produits laitieres. Name two Wines from the Bordeaux Region.)
(5) Nommez deux legume. (Name 2 vegetables)

19. Nommez le chef : (Any Five)

(Name the Chef in French.)

(a) Prépare les sauces

(b) S'occupe du petit-déjeuner

(c) Prépare les plats de poissons, les crustacés

(d) Se charge des rétis a la broche

(e) Prépare le repas pour le personnel du restaurant
(f) Prépare les glacos.

Q.19 Ecrivez la date : (Any Two)

(Write the date in French.)

13
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(a) Monday 6/7/2008

(b) Wednesday 21/3/2001

(c) Friday 30/1/2002

Q20 Quelle heure est-il ? (Any 5)
(What time is it ? Write in
French.) (a) 6.30 a.m.

(b) 4 p.m.

(c) 12 noon

(d)10:10a.m.

(e) 7.30a.m.

(f) 4.15p.m.

Q.21. Ecrivez les nombres en lettres : (Any5)
(Write the numbers in French.)
(a) 100

(b) 2

(c) 16

(d) 25

(e) 40

(f) 1st

(8) 70

Q.22 Mettez la bonne mesure :

(Put in the correct measures in French.)

(@)un__ desel

(b)un____ de tomates

(c)une___ devin

(d)un___ debiére (e)un____ de yaourt.

Q.23 Liez ‘A’ avec ‘B’ et récrivez

(Match ‘A’ with ‘B’ and rewrite the correct pairs.) ‘A’ ‘B’

(a) Pardon (i) That's nice of you
(b) A votre santé ! (ii) Agreed / ok

(c) C'est gentil (iii) Fine, thanks

(d) Bien, Merci (iv) Excuse me

(e) Bon, d’accord (v) Cheers !
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Q.24 - Give equivalants for the following in French
Donnez equivalent pour les suivent en francaise
1. Chillies
2. Mushrooms
3. Fish
4. Chicken
5. Salt
6. Milk
7. Cheese
8. Ginger
9. Brinjals
10. Grapes
11. Melon

12. Pineapple

Q.25 Match the following

Rencontez les suivent

Good morning Au revoir

Thank you Est-ce-que je peux vous aidez
May | help you Bonjour

How are you Merci

See you Comment allez

vous

Q.26 Answer following questions in French

Repondes les question en francaise
v What is your name?
What is a day today?
Today is what date?

What is your age

AN N NN

Where do you stay

Q.27 Complete following phrases

v Je vais.......... (manger) la Mangue
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TU e (aller) au Marche
Nous ............. (etre) les etudiante
Vous ............. (Parler) francaise

................. (venir) du pune
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Q.1.Explain the following Terms:

I. Computer Viii. Processing Unit
ii. Arithmetic Logic Unit (ALU) ix. Control

iii. Virus

Iv. Input cycle

V. Worm

vi. Output cycle

Vii. Trojan

Q.2.Define Virus and state two examples

Q.3.Explain Antivirus and Name two famous antivirus software brands.

Q.4.Describe briefly History of computers

Q.5.Briefly write on various Generation of computers

Q.6. Explain the characteristics of a computer system.

Q.7.Explain a computer system with the help of a block diagram.

Q.8. Enlist the advantages of a computer system.

Q.9. Enlist the dis-advantages of a computer system.

Q.10.Match the following basic operations of a computer system:

Operation

Take Input

Processing Data

Output Information

Control the

workflow

Description

Saving data and instructions so that they are available for processing as

and when required.

Directs the manner and sequence in which all of the above operations

are performed.

Performing arithmetic, and logical operations on data in order to convert

them into useful information.

The process of entering data and instructions into the computer system.

17
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The process of producing useful information or results for the user, such
Store Data . _ _
as a printed report or visual display.

Q.11. Explain the following Terms:

a. Hard disk
b. RAM
c. ROM
d. CPU
e. OCR
f. MICR

Q.12.What is Computer Hardware? Give two examples of hardware.
Q.13.What is Computer Software? Give two examples of software
Q.14.Differentiate between Hardware and Software
Q.15.Differentiate between RAM and ROM
Q.16.Differentiate between System Software and Application Software
Q.17 Differentiate between Primary Memory & Secondary Memory
Q.18.Differentiate between Input and Output Device
Q.19.Is it right to say that Hardware and software are interdependent? Explain your answer with an
example. What is secondary storage? Give two examples of secondary storage devices.
Q.20.Name different types of software. Give two examples of each type.
Q.21.Describe briefly any four input devices.
Q.22.Describe briefly any four output devices.
Q.23.Describe briefly scanning devices
Q.24.Classify and explain types of printers
Q.25.Every computer has a memory in the CPU. Why is an additional secondary memory required?
Q.26.List down the software used in hospitality industry.
Q.27 Explain any two software used in hospitality industry.
Q.28.Explain the following terms:
i. Desktop viii. Recycle Bin
Ii. Wallpaper
iii. Icon
iv. File

V. Folder

18
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vi. Pop-up Menu (Desktop properties)
vii. Search
Q.29.Enlist any three / five options found in the accessories menu.
Q.30.Enlist two ways of emptying the recycle bin.
Q.31.Explain Windows explorer and its features.
Q.32.Give the steps to remove program using control panel.
Q.33.Enlist steps involved in removing a program from the control panel.
Q.34 .Explain the functions of an operating system in a computer system
Q.35.What are the features of Windows operating System?
Q.36. Describe the following windows application: a. Paint b. Notepad c. Calculator d. Wordpad
Q.37.What is MS Word?
Q.38.Explain the term formatting in MS Word.
Q.39. Explain header and footer with the help of examples.
Q.40.What is alignment? Name the alignment options in MS Word.
Q.41.Give the shortcut keys for the following in MS Word:
* Printing a document
*  Saving the current document
*  Opening a new document
» Copying a selected text or picture
Q.42. Explain Mail and Merge Process
Q.43. Give Step by step procedure for mail merge. Mention its use.
Q.44. Explain procedure of saving document with Word.
Q.45. Describe Quick access toolbar
Q.46.Differentiate between Notepad and MS Word
Q.47 .Describe Page orientation.
Q.48.What do the following keyboard commands do in MS Excel”
Ctrl + N: To create a new workbook
Ctrl + W: To close the current workbook
Ctrl + F4: To close Excel
Ctrl + B: Apply bold formatting.
Ctrl + PageDown: To move to the next sheet

Ctrl + PageUp: To move to the previous sheet

19
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F2: To edit a cell
Ctrl + Shift + Right Arrow: To select all the cells on the right

Q.49.Explain in short the use of the following functions in MS Excel:

I.  AUTOSUM
ii. MIN

iii. AVG

iv. COUNT

v. MAX

vi. PER

Q.50.Give the Importance of excel.

Q.51.What are alignment option in MS-Excel?

Q.52.What is the function of freeze column?

Q.53.What is the function of freeze row?

Q.54.Give two formula examples using IF function?

Q.55.Explain how one can protect their excel sheet.

Q.56.Explain how one can protect their excel workbook.

Q.57.Enlist at least three / five types of charts that you can prepare using MS Office Excel.
Q.58.Draw and explain any three / five types of charts that can be prepared in MS Excel
Q.59.Enlist 5options that are available under the Home Menu.

Q.60.Enlist 5 options that are available under the Insert Menu

Q.61.Enlist 5 options that are available under the View Menu

Q.62.Give the steps to draw a border around the entire table in excel.

Q.63.Give the steps to insert a video from the video available in computer.

Q.64.Write a procedure for inserting Hyperlink in MS-PowerPoint

Q.65. Enlist & explain any 5 components of MS Office Powerpoint

Q.66.What is transition? Name any 3 transition.

Q.67.What is animation? Name any 3 animation effects.

Q.68.Explain procedure of saving document with Powerpoint

Q.69. How to insert pictures in MS-Powerpoint. Explain with example.
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Q.70. Explain the following terms:

. Animations

. Clipboard

a
b. Wallpaper
c
d. Smart Art

m

Page Orientation
f. Format Painter

g. Slide Show Menu
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COURSE CODE & NAME: AECC 205 Communication Skills

Q1. Definition Communication with a suitable example

Q2. What is the Purpose and Scope of Communication?

Q3. Explain in detail the Process of Communication with a suitable diagram/illustration
Q4. Write a short note on Types of Communication

Q5. Explain the types of Verbal Communication
Q6. Explain the types of Non-Verbal Communication

Q7. What is Body Language?

Q8. What is Mass Communication?

Q9. Discuss the importance of Eye Contact in Communication

Q10. What is formal and informal Communication?

Q11. Definition Communication with a suitable example

Q12. What is the Purpose and Scope of Communication?

Q13. Explain in detail the Process of Communication with a suitable diagram/illustration
Q14. Write a short note on Types of Communication

Q15. Explain the types of Verbal Communication
Q16. Explain the type of Non-Verbal Communication

Q17. What is Body Language?

Q18. What is Mass Communication?

Q19. Discuss the importance of Eye Contact in Communication
Q20. What is formal and informal Communication?

Q21.What is Oral Communication?

Q22. Discuss the scope and importance of Oral Communication.
Q23. What are the Advantages of Oral Communication?

Q24. What are the disadvantages of Oral Communication?

Q25. Define the term Paralinguistics (Vocalics).
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Q26. What is the meaning and importance of Paralinguistics?
Q27. Explain the various forms of Paralanguage.

Q28. Write a short note on the importance of Body Language.
Q29. Explain the Mehrabian Model of Effective Communication
Q30. Explain the following forms of Body Language - Kinesics, Haptics, Proxemics, Chronemics
Q31.Write a short note on Dressing and Grooming

Q32. What is the importance of Grooming?

Q33. Why is personal hygiene important?

Q34. Why is it essential to have standard hotel phraseology?
Q35. Give any 3 standard phrases used in hotels.

Q36. Write a short note on International etiquettes and manners.

Q37. State any 3 points to be kept in mind regarding telephone etiquettes Q38.What
are some points to be kept in mind regarding virtual meeting etiquettes?

Q39. Explain any instances of E-mail etiquettes.

Q40. Why do hotels have uniforms for their staff?

Q41. List the Parts of Speech.

Q42. Give any 5 examples of Prepositions.

Q43. Differentiate between Conjunctions and Interjections.

Q44. Give one example each of Simple Present, Present Continuous and Present Perfect.
Q45. Give one example each of Simple Future, Future Continuous and Future Perfect.
Q46. What is a Modal? Explain with examples.

Q47. Discuss the concept of Articles with suitable examples.

Q48. Differentiate between Simple Past, Past Continuous and Past Perfect.

Q49. When are Articles omitted?

Q50. State 2 exceptions to the rule of usage of ‘a’ and ‘an’.

Q51. Insert suitable Prepositions in the following sentences:

1. He deals------- Japanese silk.
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2. His style was deficient----—-variety.
3. He could not convince me--—--the truth of his statement.
4. You must deal fairly------your fellowmen.
5. Criminals are deprived ----- their liberty.
Q52. Insert suitable Prepositions in the following sentences:
1. | correspond------- her regularly.
2. Depend-----the word of your true friend.
3. Can pleasure be derived------actions that give pain to others?
4. Temperature forecast consists-----both minimum and maximum.
5. He is confined-------- bed.
Q53. Insert suitable Prepositions in the following sentences:
1. | pray you not to be angry------- me.
2. | do not agree------your proposal.
3. | agreed------him----all points.
4. Abstain-----evil and do good.
5. We waited----anxiety-----the news-----her safe arrival.
Q54. Insert suitable Prepositions in the following sentences:
1. They arrived-----the railway station just-----time.
2. The culprit is charged ------ murder.
3. She has a passion ------ reading novels.
4. | felt the necessity------doing it.
5. Is it necessary------- you to answer all the questions?

Q55. Explain the concept of Concord.

Q56. Choose the correct option and complete the following sentences using appropriate prepositions.

1. One must never deviate ................... the right path. (from/to/with/off)

2. Eventually she acceded .................... my requests. (at/fro/to/with)

3. Thereisnocure .........cccocvneeee. many forms of cancer. (to/on/for/against)
4.Sheiskeen ........ccccceeeennn, pursuing higher education in the US. (for/on/at/from)
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5. His latest novels make several allusions ...................... Hindu Mythology. (in/at/on/to)

Q57. Choose the correct option and Complete the following sentences using appropriate prepositions.

a. He was anxious ...........cccccuvee... contact his parents. (with/to/about/for)

b. She has an aptitude ................... music (on/for/with/to)

c. The indulgent mother is always blind ...................... her child’s faults. (with/at/to/on)
d.He was brought .................... by his grandparents. (on/up/over/in)

e.Heis addicted ...................... drinking. (with/to/from/at)

Q58. Choose the correct subject verb combinations in the sentences below:

a. The lady in the car (look/looks) like your mother.
b. Most of the milk (is/are) gone.

c. One of the flowers (has/have) wilted.

d. Either Ram or Shyam (is/are) coming today.

e. Here (is/are) the newspaper.

Q59. Choose the correct subject verb combinations in the sentences below:
1. The group of dancers (is/are) here.
2. Civics (is/are) my favorite subject.

Q60. What is Error Analysis? Give some common errors in English.
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